Isode

M-Switch X.400 Evaluation Guide

Configuring Ri19.0 release of Isode's X.400 Messaging Servers on Windows and Linux Platforms for
use as an X.400 Messaging System that could be used in both EDI and Aviation Solutions.
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Introduction

This guide is intended to give the reader basic information on how to configure Isode’s M-Switch,
M-Vault and M-Store X.400 Server Products. These Products combine to create an X.400
Messaging Solution. You will also use Isode’s XUXA X.400 User Agent to test the system.

More information on these products can be found at the URLs below.
https://www.isode.com/product/x-400-message-switch/
https://www.isode.com/product/x-400-message-store/

www.isode.com/product/Idap-x-500-directory/

Objectives

In this guide you will be shown how to configure the X.400 PRMD “/P=X400/A=Isode/C=GB/ and
to configure connections to other X.400 MTAs.

The diagram below gives an overview of this setup.

System Overview

M-Console
GUI

LDAP M-Vault Console

M-Vault o

X.400 P7

M-Store X.400

Evaluation Guide: M-Switch X.400 Page 3 of 65



Isode

By the end of this guide you will have:
1. Installed the M-Switch, M-Vault, and M-Store X.400 products.
2. Configured M-Switch and M-Vault using M-Console.
3. Provisioned Users using M-Console.
4. Configured XUXA to connect to these Users.
5. Logged in using XUXA and sent Messages between Local X.400 Users
6. Created a connection to an external X.400 MTA server (M-Switch MIXER).

For the purposes of this evaluation, we have assumed this is a "clean" installation of the Isode
Software on to a physical or virtual machine. If you have previously installed the Isode Software
on the hardware or VM you are using for this evaluation, please make sure you have
completely uninstalled that version and any configurations before proceeding.

This guide is part of a set of three Guides; M-Switch SMTP, M-Switch MIXER and M-Switch X.400
and they connect to each other as below.

M-Switch SMTP, M-Switch MIXER & M-Switch X.400

M-Switch SMTP M-Switch MIXER

Domain: internet.net Domain: mixer.net
Maps to /P=Internet/A=Isode/C=GB/ PRMD: /P=MIXER/A=Isode/C=GB/

Users:

user.one@internet.net

Maps to
/G=user/S=one/P=Internet/A=Isode/C=GB/

user.two@internet.net
Maps to
/G=user/S=two/P=Internet/A=Isode/C=GB/

M-Switch X.400

PRMD: /P=X400/A=Isode/C=GB/
Maps to x400.net

Users:
/G=user/S=one/P=X400/A=lsode/C=GB/
Maps to

user.one@x400.net

/G=user/S=two/P=Internet/A=Isode/C=GB/
Maps to
user.two@x400.net
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Using Isode Support

You will be given access to Isode support resources when carrying out your evaluation. Any
queries you have during your evaluation should be sent to isode.support@isode.com. Please note
that access to the Self-Service Portal for web-based ticket submission and tracking is not available
to evaluators.
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Preparing the Server Environment

You should visit https://www.isode.com/support/platform-support/ to discover which operating
systems are supported for Isode evaluations.

Naming the Server

In this eval guide the machine name is: [ISODE-X400-EVAL
In this eval guide there is no dns suffix for the server.
Alternatively, you may use your own names or add dns entries in a dns server or hosts file.

Install the Isode Software

Follow the instructions in the release notes for the appropriate platform for the products. For this
guide, the following products were used:

M-Switch 19.0v21
M-Vault 19.0v21
M-Store X.400 19.0v21
MAS 11

On Windows, select the default install options when executing the installer for the Isode
Products.

Remember to install an appropriate java runtime engine (refer to product release notes) and in a
Windows environment the visual c++ redistributable package.

On Linux, install all the RPMs with the command:
# sudo rpm -i ISD*.rpm
Please use a supported web browser as documented in the product release notes.

Activating the Isode Products

The Isode Products are Activated using the Isode Messaging Activation Server (MAS). You should
refer to the MAS Evaluation Guide for how to Activate the Products.
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Creating the Messaging Configuration

Running the M-Console Configuration Wizard

In this chapter we will create the Messaging Configuration, which is held in M-Vault, and use M-
Console to do this.

To start M-Console on Windows from the Windows Start Menu; Windows—>Isode 19.0>M-
Console

Start M-Console
. Isode 19.0
SPIF Editor

Q Isode Service Configuration

LogConfig (Isode Log Configuration...

M-Vault Console

@ MConsole (Message Switch Console)

55066 Console
m Sodium (Secure Open Data, Identity...

i Sodium CA (Sodium Certificate Auth...

Sl XUXA (X400 Demo User Agent)

£ frype here to search

On Linux type the command:

# /opt/isode/isode/bin/mconsole

You will see the following prompt.

Encrypt the Bind Profile

‘ ' . This operation encrypts sensitive data in the bind profile file, which means that the
‘ bind profile can be used to store passwords (for simple authentication), and
passphrases (for X.509 identities).

Once the data is encrypted, you will be prompted to enter your passphrase whenever
an application needs to decrypt data in the profile file; failing to enter the correct
passphrase means you will not be able to use any saved bind profiles. Note that once
you have encrypted the data, you cannot subsequently choose to decrypt it.

Do you really want to encrypt your bind profile file?

Click “Yes”
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Enter Bind Profile Passphrase

Enter Profile passphrase X

Please enter a Profile passphrase. This will be used to encrypt all of the passwords,
and means that you will be prompted for this passphrase from now on whenever you
run Sodium, M-Vault Console, MConsole or M-Link Console.

Passphrase: | | I

Verify Passphrase: I l

OK Cancel

Enter your chosen passphrase, for evaluations we suggest “secret” so that if you need Isode
Support we do not have to fix forgotten passwords etc.

Bind Profile Passphrase Entered

Enter Profile passphrase X

Please enter a Profile passphrase. This will be used to encrypt all of the passwords,
and means that you will be prompted for this passphrase from now on whenever you
run Sodium, M-Vault Console, MConsole or M-Link Console.

Passphrase: l ecssce |

Verify Passphrase: I cecees I

Click “OK”

Bind Profile Encrypted

Bind profile file encrypted X

The bind profile file has been encrypted

Click “OK”
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M-Console Welcome Screen

[Z]] MConsole (Welcome to Message Console) - O X
File Window View Help

%] Welcome to Message Console X " <

A
Welcome to Message Console
If you see this screen, then you may be running MConsole for the first time on this computer.
The Messaging Configuration is held in a Directory Server (DSA).
If you wish to set up a DSA and a complete new Messaging Configuration on this computer, choose the “Create a new DSA and
Messaging Configuration..." option.
If you wish to create a Messaging Configuration using a DSA which is already running on another computer choose the "Create a new
Messaging Configuration..." option.
The other options are for management of existing Messaging Configurations, and can also be accessed from the View menu
E Create a new DSA and Messaging Configuration... 8 Create a new Messaging Configuration...
/’/ Connect to an existing Messaging Configuration... u Open your default Messaging Configuration (if any)
i Monitor existing Message Switches Monitor existing X.400 Message Stores
Track messages % List quarantined messages
v
© Help
Select “Create a new DSA and Messaging Configuration.
Enter a User Name
D Choose the Initial Directory User's Name X

Choose the Initial Directory User's Name

You must provide the name of the person who will be set up as the initial manager of the Directory and MTA
configuration, and will also be able to connect to the Queue Manager via SOM for management and
monitoring purposes. You will be able to add extra managers with more restricted rights once the Messaging
Configuration has been set up.

User name

OK Cancel

Typically, we use “Messaging Admin” here, but you can choose your own if you wish.
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User Name Entered

[Z] Choose the Initial Directory User's Name X

Choose the Initial Directory User's Name

You must provide the name of the person who will be set up as the initial manager of the Directory and MTA
configuration, and will also be able to connect to the Queue Manager via SOM for management and
monitoring purposes. You will be able to add extra managers with more restricted rights once the Messaging
Configuration has been set up.

User name | Messaging Admin)|

o1l one

Enter your User Name and Click “OK”.

Enter Base DN

[Z] Create Directory Server O X
y

DIT structure configuration

Adjust the DNs provided by the template to suit your requirements

Base DN

o=messaging

Initial Directory User: This user is put into all the initial groups, and the bind profile created will
bind as this user. Afterwards you can create more users and change which users are put in
which roles. You should change the common name to a suitable value for a real person.

cn=Messaging Admin,cn=Users,o=messaging

< Back Finish Cancel

Enter the Base “Distinguished Name” (DN) for your directory server. You can use the default or
choose one of your own.
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Base DN entered

[ Create Directory Server ] X

DIT structure configuration
Adjust the DNs provided by the template to suit your requirements

Base DN
I 0=X4(X1

Initial Directory User: This user is put into all the initial groups, and the bind profile created will
bind as this user. Afterwards you can create more users and change which users are put in
which roles. You should change the common name to a suitable value for a real person.

cn=Messaging Admin,cn=Users,0=X400

< Back Finish Cancel

In this guide we have changed the Base DN to “X400”. Click Next>"

Enter Password

[Z] Create Directory Server m] X

Password configuration

Passwords are auto-generated, but can be modified here if required

Initial Directory User: cn=Messaging Admin,cn=Users,0=X400

Password: l ..l..l'.‘..l.l I ] Show

Copy password to clipboard | Save password to file

[[JRecord user authentication times (authTimestamps)

Password Hashing

Hashed passwords are more secure, but are not compatible with password-based SASL
mechanisms other than PLAIN, LOGIN and SCRAM-SHA-1.

Note that while non-hashed passwords may be recovered from the DSA database, hashed
passwords are NOT recoverable.

[4] Hash all passwords using SCRAM-SHA-1

< Back Finish Cancel

The GUI will auto-create a Password for the initial directory user — but you can change this to one
of your own. In this guide we will use “secret”.
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Password entered

[ Create Directory Server a X

Password configuration

Passwords are auto-generated, but can be modified here if required

Initial Directory User: cn=Messaging Admin,cn=Users,0=X400

Password: I secret l M Show

‘Copy,. d to clipb :." Save p d to file

P

[JRecord user authentication times (authTimestamps)
Password Hashing
Hashed passwords are more secure, but are not compatible with password-based SASL
mechanisms other than PLAIN, LOGIN and SCRAM-SHA-1.
Note that while non-hashed passwords may be recovered from the DSA database, hashed
passwords are NOT recoverable.
[ Hash all passwords using SCRAM-SHA-1

< Back Finish Cancel

Always check the password you have entered by checking the “Show” checkbox, then click
“Next>".
Bind Profile Summary

[ Create Directory Server m] X

Bind Profile Names and Filesystem Location

Use the suggested values, or enter your own

Management bind profile name: Used to manage the DSA in M-Vault Console

| cn=dsa,0=X400 / Messaging Admin l

The folder which will contain the directory server's database and configuration (this folder will be
created in order to initialize the DSA):

[ c:lsode\d3-db | | Browse

< Back Finish Cancel

Click “Next>".
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Directory Server Summary

[Z) Create Directory Server O X

Address Configuration

Enter the server hostname / IP address and ports to listen on

Hostname: | ISODE-X400-EVAL

Enable:
LDAP DAP

Port numbers:
(O Standards, no messaging: 389 / 102
O Standards with messaging: 389 / 19999
(@ Isode default: 19389 / 19999
O Alternate 2: 29389 / 29999
O Alternate 3: 39389 / 39999
O Alternate 4: 49389 / 49999
O Alternate 5: 59389 / 59999

[ Advanced Editor Recheck Ports |

< Back Finish Cancel

Click “Next>".

Directory Server Configuration Confirmation

[ Create Directory Server (] X

Confirm Details
Check the details below before creating the DSA

DSA creation template:
Simple DSA setup for Messaging Evaluations
DSA address:
Host ISODE-X400-EVAL, X.500 on port 19999, LDAP on port 19389
DSA name:
cn=dsa,0=X400
Bind profile name:
cn=dsa,0=X400 / Messaging Admin
Password hashing:
SCRAM-SHA-1

< Back Next > Cancel

Click “Finish”.
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You will see the following - wait.

Directory Server Creation and Starting

Creating and starting DSA ...

(— Abort

[] Background Task Progress X

You will then see the following screen.

Product Activation Summary

[ Create a new MHS configuration O X
Product Activation

The Product Activation information on this system is shown here.

Product Activation information: M-Switch is activated, Product is "M-Switch X.400"
Activated subfeatures are: TLS, x400

The remainder of this Messaging Configuration wizard will create a configuration appropriate for
M-Switch X.400

If this is incorrect, contact support@isode.com for a suitable Product Activation Key

< Back Finish [ cancel

Click “Next>".

Isode
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Set the Messaging Configuration Base DN

[ Create a new MHS configuration

Set the Messaging Configuration Base DN
Select the entry under which a Messaging Configuration entry will be
created

> 0=X400

If you provide an organization name, an entry for the organization name provided will be
created automatically under the entry you select.

[[] Create organization name

Messaging configuration name

I Messaging Configuration

Base DN: 0=X400
MHS DN: cn=Messaging Configuration,o=X400

< Back ‘ Next > Finish Cancel

You should select the top entry, 0=X4o00 in this example.

Set the Messaging Configuration Base DN

[ Create a new MHS configuration

Set the Messaging Configuration Base DN
Select the entry under which a Messaging Configuration entry will be
created

> 0=X400

If you provide an organization name, an entry for the organization name provided will be
created automatically under the entry you select.

[] Create organization name

Messaging configuration name

[ Messaging Configuration

Base DN: 0=X400
MHS DN: cn=Messaging Configuration,o=X400

< Back Finish Cancel

Click “Next>".
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Set the Hostname

[Z] Create a new MHS configuration

Hostname
The hostname will be used, among other things, to set the network
addresses
Hostname

Enter the fully qualified host name of the machine that will be running this server.
For example, mail.isode.com. If not possible, then use the host name.

ISODE-X400-EVAL

DSA Authentication

Show

SASLP d

< Back Finish Cancel

This should display the Hostname of your server, if it does not change it to the Hostname of your
Server. Do not change the SASL Password. Click “Next>".

Administrator details

[ Create a new MHS configuration

Hetail

Administrator authentication

Configure the authentication information to be used by administrators
of MTAs within this configuration

This information will be needed to connect to the QMGR with authentication, and will be used by
the Switch Operations View, Switch Configuration view (for Outbound Connection Testing) and

the Event Viewer.

Admin Users Parent DN

The location beneath which new Admin Users will be created

Parent DN | cn=Users,0=X400 Pick...

(® Use existing SASL Id

user name | messaging.admin@ISODE-X400-EVAL Select

(O Create new SASL Id

Admin user name mtaAdmin @  sasl.ISODE-X400-EVAL

Show

< Back Finish Cancel

You should not have to make any changes here. Click “Next>".
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X.400 Configuration

[ Create a new MHS configuration m| X

X.400 configuration
Enter the O/R Address prefix to be the local O/R Address space for this
_MTA
X.400 Address Prefix
IS0 3166 Country Code | |

Osinglepace ADMD|[ | [OMissing pRMD[ |

Organization [ I

out | | ouz | |
ous | | ous | |

(® Create an X.400 Message Store for local P7 users
(O Create a legacy X.400 Message Store
O Do not create an X.400 Message Store

< Back Next > Finish Cancel

You now need to set your X.400 Address Space - /P=X400/A=Isode/C=GB/ in our example.

X.400 Configuration

[Z] Create a new MHS configuration a X

X.400 configuration

Enter the O/R Address prefix to be the local O/R Address space for this
MTA

X.400 Address Prefix

1SO 3166 Country Code United Kingdom Ei&

[Single Space ADMD OMissing PRMD

Organization | |

out | | ouz | |
ous | | ous | |

(® Create an X.400 Message Store for local P7 users
(O Create a legacy X.400 Message Store
(O Do not create an X.400 Message Store

< Back Finish Cancel

Enter the details and leave “Create and X.400 Message Store for local P7 Users” Checked. Click
“Next>".
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Service File Creation

Create a new MHS configuration a X
Service File Creation
Create default configuration files to enable service startup
This file allows the MTA to connect to the DSA, and download its configuration.
Create mtabootxml | C:\Isode\etc\switch\mtaboot.xml | [ Browse<
M-Store-X400 uses the pumicetailor file to store its configuration.
Create pumicetailor | C:\Isode\etc\pumicetailorxml | Browse |
< Back ' Next > v Cancel
Click “Finish”.
Service File Creation
Create Isode Services ] X
Create Isode Services
Select the services from the service groups that you want to create
M-Vault M-Vault
© M-Switch [J1sode M-Vault Directory Server
e M-Store
Audit Database
=]
Click “Finish”.

Isode
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Switch Configuration Management

[Z] MConsole (Switch Configuration Management): messaging.admin@ISODE-X400-EVAL - ] X
File Window View Messaging Operations Help

% Welcome to Message Console ] Switch Configuration Management )2 A

v || Routing Trees
> @ Main Routing Tree ) ) ) ) ) .
v [ Message Transfer Agents A Rou_tmg Tree defines a hierarchy of internet domains enq X.400 addresses within an
5 3 ISODE-X400-EVAL organization, and represents the registration of MTAs within the address namespace.

_J External Message Transfer 4 | The MTA uses Routing Trees to determine how to route addresses. Routing Trees can be Internet,
v [L) X400 Message Stores X.400 or both. A MIXER Internet/ X.400 tree would normally have two branches, one for each
> (& Main Message Store protocol.

Normally, there will be one Routing Tree per messaging configuration, and this will be shared
by all the objects in the configuration which need access to routing information.

The purpose of routing is to determine for messages and recipients
* next-hop MTA (or local delivery)
* the local channel to be used for that MTA

The procedure is:

* use Routing Tree(s) to find potential MTAs (described in this section)

* look at the channels of the remote MTA and find matches among the inbound protocols on
those channels to the outbound protocols of the channels belonging to the local MTA.

Routing information is held in Routing Trees. These hierarchical structures consist of routing
information held in nodes in a tree like structure. Each node represents one component of an
OR Address (or Internet address). Each node may contain routing information which describes N

Apply | Cancel

' (7) Helpk

You have now created your base M-Switch X.400 Configuration. We now need to start Services.
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Starting the Services

On Linux use the following command.

# systemctl start pp
# systemctl start pumice

From the Start Menu Windows—>Isode Rig.0>Isode Service Configuration

Isode Services Configuration Tool

- Isode 19.0

SPIF Editor

»

=

Isode Service Configuration

LogConfig (Isode Log Configuration...

MConsole (Message Switch Console)

M-Vault Console

S$5066 Console

Sodium (Secure Open Data, Identity...

Sodium CA (Sodium Certificate Auth...

WEEHE S

Sl UXA (X.400 Demo User Agent)

pe ffype here to search

The following screen is displayed.

Isode Services Configuration Tool

Service Configuration = a X
|
| Service Configuration Operations View Help

| Isode Services

+Add 2 Refresh All ) Refresh P Start X Remove

& Isode M-Vault DSA Creation §
@ Isode MAS General Recovery Advanced
v @ Isode DSA cn=dsa,0=X400 / N
v @ Isode M-Switch Queue Ma
@ Isode M-Switch OSi List|  Service Status | Stopped |

@ Isode M-Store X.400 Serve Start Type (e ¥

Service Name ‘ Isode M-Vault DSA Creation Service

Product Activation Status

Product Latest Version Expiration Valid
M-Vault 19.1 31-Dec-2026 @ VES

Select the “Isode DSA cn=dsa, o=x400...” Service.
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Isode Services Configuration Tool

&% Service Configuration

= O X
Service Configuration Operations View Help
Isode Services
o Add (3] Refresh All [3) Refresh b Start P Start Tree @) Stop XX Remove
O Isode M-Vault DSA Creation §
o Isode MAS General Recovery Advanced
v ) Isode DSA cn=dsa,0=X400/ \ Service Name I Isode DSA cn=dsa,0=X400 / Messaging Admin I A
v @ Isode M-Switch Queue Ma ) =
@ Isode M-Switch OSi Lis{|  Service Status | Running ]
@ Isode M-Store X400 Server | gy Type Nanai
Product Activation Status
Product Latest Version Expiration Valid
M-Vault 19.1 31-Dec-2026 Q@ ves
< >
r 1 >
Appl |
> 5 pply | Cancel
Abort

Change the “Start Type” from “Manual” to “Automatic” using the Drop Down and Click Apply.

Do the same for the “Isode M-Switch Queue Manager”, “Isode M-Switch OSI Listener” & “Isode
M-Store X.400 Server”.

Isode Services Configuration Tool

4% Service Configuration

- [m] X
Service Configuration Operations View Help
“Isode Services' S
o Add 3] Refresh All [3) Refresh P Start P Start Tree €) top X Remove
@ !sode M-Vault DSA Creation S
@ Isode MAS General Recovery Advanced
v @ Isode DSA cn=t.‘!sa,o=X400/ N Service Name [ Isode M-Switch Queue Manager 18
v @ Isode M-Switch Queue Ma ) | Friendly name for the s
@ Isode M-Switch OSi List| ~ Service Status | Stopped ——
@ Isode M-Store X400 Server| ¢ Tpe |[BilomeichY
Product Activation Status
Product Latest Version Expiration Valid
M-Switch 19.1 31-Dec-2026 @ VES
M-Switch-Encryption Not activated N/A 0 NO
< > v
Appl |
v = pply Cancel
Abort

Then Start the “Isode M-Switch Queue Manager”, “Isode M-Switch OSI Listener” & “Isode M-
Store X.400 Server” services.

Evaluation Guide: M-Switch X.400 Page 21 of 65



Isode Services Configuration Tool

Isode

%, Service Configuration
Service Configuration Operations View

Isode Services

Help

@ Isode M-Vault DSA Creation S ‘
@ Isode MAS
v @ Isode DSA cn=dsa,0=X400 / N
v @ Isode M-Switch Queue Ma
@ 'sode M-Switch OS| List

© Isode M-Store X.400 Serve:

Abort

General Recovery Advanced

o Add [2) Refresh All [3) Refresh b Start b Start Tree @) Stop XX Remove

Service Name l Isode M-Store X.400 Server

Service Status l Running

Start Type Automatic v
Product Activation Status

Product Latest Version Expiration Valid
M-Store-X400 19.1 31-Dec-2026 Q@ ves
< >
v
Apply | Cancel

This completes the Windows Services Configuration. We will now return to M-Console to
configure the X.400 P7 Users.
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Configuring the X.400 P7 Users
From M-Console select View—>Configuration>X.400 Mailbox Management.

M-Console X.400 Mailbox Management

[] MConsole (Switch Configuration Management): messaging.admin@ISODE-X400-EVAL
File Window View Messaging Operations Help

& Welcome to Live Operations > I
v |_| Routing Configuration > Switch Configuration Management
> @ Main Audit Information X.400 Mailbox Management
v [ Message s .
5 = Isopl BJ User Agent ) Authenticated Entities Management
“J Extemal (g Event Viewer 10w to route addresses. Routing Trees can be Inter
v ) X400 M« B Alerts 1e for each protocol.
> (& Main :
Welcome View :r messaging configuration, and this will be share«
[]  Shaper Configuration File Editor
@3 Options messages and recipients
kd  Make new "Switch Configur..." views look like this one A
X Make new "Switch Configur..." views use factory settings
B3 Next View As (described in this section)
. . . and find matches among the inbound protocols ¢
[Wi Previous View local MTA.
AR Close Ctrl+W
DAL SR AP AT A e i e v iemms Thoasa hiscaes hisal sbviirbisomr mrmmrick nf enidbionm
M-Console X.400 Mailbox Management
[Z] MConsole (X.400 Mailbox Manag ) gi in@ISODE-X400-EVAL - X
File Window View Help
%] Welcome to Message Console Switch Configuration Management | & Alerts ‘1 X.400 Mailbox Management X\
y i

Fernplsts  Add Other User

v |_| Routing Trees
> @ Main Routing Tree
| User Templates X.400 User List

The table below can display all the X.400 users in this messaging configuration.

X400 User List  X.400 User Search  X.400 Integrity Check

As the operation can be slow, the table is only loaded when the ‘Refresh Table' button is clicked.
Itis also possible to list a limited number of users by using the 'X.400 User Search’ tab.

Routing Tree Main Routing Tree v | | Refresh Table | | Save

Table Columns to show [ Local Address, O/R Address , Type Edit

Expand the “Main Routing Tree” on the left until you reach your X.400 Address Space
(/P=X400/A=Isode/C=GBY/) in this example and select it.

M-Console X.400 Mailbox Management

[Z] MConsole (X.400 Mailbox Management): messaging.admin@ISODE-X400-EVAL - X
File Window View Help
%] Welcome to Message Console | Switch Configuration Management | @ Alerts ,J‘ X.400 Mailbox Management X
<] & < =] L - L >
Add P7 Mailbox Add P3 User Agent Add X.400 Distribution List Add X.400 Redirect  ~dd using Termplate Add Other User Search by Address Search by User

v [ Routing Trees

v @ Main Routing Tree Routing Tree Node
v (p C=GB These routing tree nodes can be added or removed using the Switch Config Management view
v (9 ADMD=Isode
> (® PRMD=X400

| User Templates

Click “Add P7 Mailbox.
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M-Console X.400 Mailbox Management

[Z] Add P7 Mailbox using Personal Name Naming [m] X

Address Form

Choose the address form to use for this node

Address form
(® Personal Name
(O Common Name
(O Common Name and Personal Name
O Organizational Unit
(O AMHS (Aviation) CAAS Addressing
(O AMHS (Aviation) XF Addressing
O Other

< Back Finish Cancel

Select “Personal Name” (or whatever suits your deployment) and Click “Next>".

M-Console X.400 Mailbox Management

[Z] Add P7 Mailbox using Personal Name Naming O X

Node name (Personal Name Addressing)

Enter the Personal Name for this node

Surname | |

Given name [

Initials I

Generation Qualifier [

< Back Next > Finish Cancel

Enter “one” for “Surname” and “user” for “Given name”.
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M-Console X.400 Mailbox Management

[] Add P7 Mailbox using Personal Name Naming a X

Node name (Personal Name Addressing)

Enter the Personal Name for this node

Surname | one I
Given name I user I
Initials [ |

|

Generation Qualifier |

< Back . Finish ' Cancel

Click “Next>".

M-Console X.400 Mailbox Management

[] Add P7 Mailbox using Personal Name Naming a X

O/R Address
Confirm the chosen O/R Address for this node

O/R Address | /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ [ Edit |

< Back | Next > Finish Cancel

Click “Next>".
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[Z] Add P7 Mailbox using Personal Name Naming [m}

White Pages (Address Book) Entry
Configure a White Pages entry for this address

(O Do not set up a White Pages entry
(® Create new White Pages entry

Directory Root

Select where in the DIT the White Pages entry will be created

Common Name user one

Initials
Surname one
Given name user

(O Amend existing White Pages entry
Directory Entry

Select the existing Directory entry to amend

Advanced White Pages values can be set within the White Pages tab in X.400 Mailbox
Management

Directory | cn=White Pages,o=X400 Pick...

Directory Entry  cn=White Pages,0=X400 Pick...

< Back ' Finish Cancel

Click “Next>".

M-Console X.400 Mailbox Management

MTA and Message Store Details
Configure which Message Store, MTA and delivery channel this user will

[Z] Add P7 Mailbox using Personal Name Naming a X

use
Message Store

cn=Main Message Store,cn=Messaging Configuration,0=X400 v
Supporting MTA

| cn=ISODE-X400-EVAL,cn=Messaging Configuration,0=X400 v:

P3 Delivery Channel

p3deliver v

Finish | Cancel

Click “Next>".

Isode
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M-Console X.400 Mailbox Management

[] Add P7 Mailbox using Personal Name Naming a X

Passwords
Set the User's P7 and P3 passwords

P7 Message Store Password [ 0000000000 0000000 | Show

P3 Access Password | 0000000000000000 | Show

< Back Next > Cancel

Change both Passwords to “secret” and Click “Show” on each of them to confirm.

M-Console X.400 Mailbox Management

[Z] Add P7 Mailbox using Personal Name Naming a X

Passwords
Set the User's P7 and P3 passwords

P7 Message Store Password | secret | Hide

P3 Access Password I secretl I Hide

< Back Next > Cancel

Click “Finish”.
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[ MConsole (X.400 Mailbox M. ) ing.admi

ging ISODE-X400-EVAL

File Window View Help

—
8] Welcome to Message Console (1 Switch Configuration M | @ Alerts (

7 =]
Add P7 Mailbox Add P3 User Agent Add X.400 Distribution List Add X.400 Redirect

Add usi Jste | Add Other User Search by Address Search by User
v [_J Routing Trees
v @ Main Routing Tree Message Store  Routed UA  Synonyms, Aliases and Redirects White Pages
v (p C=GB
v (® ADMD=lsode P7 Message Store Password I Enter value to reset password I Show
v (® PRMD=X400
2 G=user+S=one P3 Access Password l Enter value to reset password I Show
| User Templates
Mailbox Name | oned |
Keep a copy of submitted messages O Yes (@ Default O No
Alternate Sending Addresses
ORAddress DN
o Add
2 Remove
A Edit
= Copy
= Paste
v
Apply | Cancel
« ”
Repeat the process for “user two” (/G=user/S=two/P=X400/A=Isode/C=GB/).
M-Console X.400 Mailbox Management
[Z] MConsole (X.400 Mailbox M, ) ing.admin@ISODE-X400-EVAL - X
File Window View Help
%] Welcome to Message Console |+ Switch Configuration Manag |. Alerts X.400 Mailbox Management X\\*
@ .
Add P7 Mailbox Add P3 User Agent Add X.400 Distribution List Add X.400 Redirect ~dd using Termplate Add Other User Search by Address Search by User
v [/ Routing Trees A
v @ Main Routing Tree Message Store  Routed UA  Synonyms, Aliases and Redirects White Pages
v (» C=GB
v ( ADMD=lsode P7 Message Store Password I Enter value to reset password | \»Show‘
v (® PRMD=X400 —
& G=user+S=one P3 Access Password | Enter value to reset password | | Show
2 G=user+S=two
[Z User Templates Mailbox Name | two0 l
Keep a copy of submitted messages (O Yes (@ Default (O No
Alternate Sending Addresses
ORAddress DN
. deAdd |
X Remove
A Edit
Copy
4= Paste
v
Apply Cancel

This completes the configuration of the System for Local Users. We will now test the system with
XUXA.
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Testing the System with XUXA

XUXA is started on Linux as below.

% /opt/isode/bin/xuxa

On Windows Start>Isode R19.0>XUXA (X.400 Demo User Agent)
XUXA Start

Isode 19.0

SPIF Editor

Isode Service Configuration

LogConfig (Isode Log Configuration...
MConsole (Message Switch Console)
M-Vault Console

$5066 Console

Sodium (Secure Open Data, Identity...

Sodium CA (Sodium Certificate Auth...

EEEREEEERL

XUXA (X.400 Demo User Agent)

L Type here to search

The following splash screen is displayed.

XUXA Splash Screen

Isode

XUXA
X.400 Demonstration User Agent

Wait... then the following screen is displayed.
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XUXA Initial Screen

B White Pages Browser X

Select an existing user in the Directory, to use its O/R address to create an account

v <World>
> 0=X400

Selection | 0=X400 ]

I oK I ’ Cancel ‘

Expand O=X400 and cn=White Pages as follows.

XUXA White Pages Selection

B White Pages Browser X

Select an existing user in the Directory, to use its O/R address to create an account

v <World>
v 0=X400
cn=Address Book
cn=Groups
cn=Messaging Configuration
cn=Users
cn=White Pages
8 cn=userone
8 cn=usertwo

v v v

Selection | cn=user one,cn=White Pages,0=X400 I

[ ok ]| concer |

Select “cn=user one”, Click “OK”.
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B User Password

Enter the user's P7 Message Store or P3 MTA password

Isode

OK Cancel
Enter the password you configured (“secret” in our example). Click “OK”.
XUXA Client
B XUXA (X.400 Mail User Agent) - /G=user/S=one/PRMD=X400/ADMD=lsode/C=GB/ - X
File Message View Help
T R I X | = -
| Get Mail Write Reply  Reply Al Forward AddrBook Delete Mode
& Mailboxes] = B || P From Subject Received Size Sec
©4 Inbox
1 Outbox
[ Sent
A Reports
@ Trash
A PrevnewI'_Q Log‘ = 0
From: Message Security:
./ Not Signed
~ No Security Label
Subject:
Date: Bodyparts:
Priority: Normal

®  X.400 MTS Parameters

Server status

Click “Write”.
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XUXA Client

2 New Message
File Help

Send Attach g

From: | /G=user/S=one/PRMD=X400/ADMD=lsode/C=GB/ v Message Security:
@ o/ Don't sign message v

© No Security Label

Priority:
Priority: | Normal v|

YP:

Subject: | |

®  X.400 MTS Parameters

Click the “Address Book” Icon below “From:”

XUXA Client

4 Address Book

The World v | Not bound | Edit with SODIUM |

8 /G=user/S=two/PRMD=X400/ADMD=Isode/C=GB/
8 /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ To: ->
CC->
BCC: ->
Alt Recipient: ->
Attribute Value

[ ok ]| cancel

Select each of the entries one by one and Click “Two”.
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XUXA Client
\& Address Book X
[The World | Not bound | Edit with SODIUM
/G=user/S=two/PRMD=X400/ADML
8 /G=user/S=two/PRMD=X400/ADMD=lsode/C=GB/ /G=user/S=one/PRMD=X400/ADML
8 /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/
< >
CGC->
BCC: > |
Alt Recipient: ->
Attribute Value
DN cn=user one,cn=White Pages,0=X400
O/R Address /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/
ok || Cancel
Click “OK”.
XUXA Client
2 Test - m] X
File Help
Send Attach me—
From: l/G=user/S:oneIPRMD:XdO(VADMD:Isode/C:GB/ v|  Message Security:
(| [T /Geuser/s=two/PRMD=X400/ADMD=Isode/C=GB/ [PerRecip | /' Don'tsign message >
~ | T0:  /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ [PerRecip | B No Security Label
Priority:
Subject: | Test |

YP

®  X.400 MTS Parameters

User One and User Two

Sent by User One.l

Enter some text in the Subject and Body the clock the “Send” Icon (Top Left).
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XUXA Client

B3 Send Message

@ Message submitted.

Message Submission ID:

[/PRMD=X400/ADMD=Isode/C=GB/;ISODE-X400.0286001-250220.162453]

IPM ID: 1 250220162453Z*/G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/

Submission time: 250220162453Z

It took 674 milliseconds to construct and send the message

Click “OK”.

XUXA Client

B XUXA (X.400 Mail User Agent) - /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/

Isode

=] X
File Message View Help
& A . B R M .
GetMall  Write Reply  Reply Al Forward AddrBook | Delete Mode
@ Mailboxes] = B |/ p  From Subject Received Size Sec
-] /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ Test 20/02/2025, 16:24 1Kb o/
@by | ] <SYSTEM> 1Kb o)
 Outbox ] <SYSTEM> 1Kb W)
(=3 Sent ] /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ IPN 20/02/2025,16:24  1Kb J
A Reports
@ Trash
17 T =
(] Preview| <} Log | (]
From: /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ Message Security:
TO: /G=user/S=two/PRMD=X400/ADMD=lsode/C=GB/ /| Signed (Not signed)
TO: /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/
No Security Label
Subject:  Test
Date: 20/02/2025, 16:24 Bodyparts:
Priority:  Normal T 1AS Text
®  X.400 MTS Parameters
User One and User Two
Sent by User One.
A new message has arrived ‘ Server status = 767 @

You will now see the above displayed. We now need to configure XUXA for User Two.

From the Top Menu Select File->Preferences.

XUXA Client

B3 XUXA (X.400 Mail User Agent) - /G=user
File Message View Help
& Getall Mail Ctrl+G

{3] Open Address Book Ctril+A ¢

Preferences

Exit Ctrl+X ¢
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B Preferences O X
\: Xuxa Accounts = v .
> Xuxa Accounts
» Xuxa General Make Default | s Add
user one Sall z .
[ Copy <_Delete
Default Account
‘ Import Preferences Export Preferences Delete All Preferences
\'Restoregefaults'\ [ Apply
Apply and Close v Cancel .
Click “Copy”.
XUXA Client
B New Account Editor X

Type the new account name

[ o

Cancel J

Enter a Name for “User Two”.

XUXA Client

= New Account Editor

X

Type the new account name

I user two |
| OK Cancel 1
Click “OK.
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B3 Preferences

| type filter text

> Xuxa Accounts
> Xuxa General

Restore Defaults Apply
Apply and Close Cancel
Expand “Xuxa Accounts and select “P7 Message Store”.
XUXA Client
B Preferences m] X
type filter text P7 Message Store (SR A ¢
b XuxBa Accounts Connection Information
S Message Store P ion Address | "3001"/URI+0000+URL+ itot://ISODE-X400-EVAL:3001
DSA and Address Book
General Message Store User (O/R) l /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ I Edit
P3 Submission M Store User P d I -
P7 Message Store essage Store User Passwort secr
Reports Message Store User DN I cn=user one,cn=White Pages,0=X400 I Pick
Security : =
5 Xuxa General 5 Bind to the Message Store \d Search
Check for messages at startup
[] Disable configuration requests in bind op
[ Use a new connection for each message submission
[[J Use a new MS connection for Get Mail
[ Don't confirm message deletion
[ Register an lert for new g
[JPop up an alert window when an autoalert is received
[[J Automatically check for new every check period (below)
Check period (in seconds) I 0
The messages will be fetched
@ at startup time O on demand
Maximum mailbox size I 100
Restore Defaults| | Apply

m} X
Xuxa Accounts Dy v w
Meke Defoult | | o= Add

user two v
| X Delete

The default account is user one

v Import Preferences | | Export Preferences ' Delete All Preferences |

Isode

Apply and Close ’ Cancel

Change the “Message Store User (O/R) and “Message Store User DN” as follows.
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B Preferences

\' type filter text

v Xuxa Accounts
Bodyparts
DSA and Address Book
General
P3 Submission
P7 Message Store
Reports
Security

> Xuxa General

O X
P7 Message Store vy
Connection Information
Message Store Presentation Address | "3001"/URI+0000+ URL+itot://ISODE-X400-EVAL:3001 |
Message Store User (O/R) I /G=user/S=two/PRMD=X400/ADMD=Isode/C=GB/ | [ Edit ‘
Message Store User P, d I secret |
Message Store User DN [ cn=user twol cn=White Pages,0=X400 l ‘ Pick ‘
‘ %5 Bind to the Message Store \ Search
Check for messages at startup
[ Disable configuration requests in bind operations
[J Use a new connection for each message submission
[J Use a new MS connection for Get Mail
[ Don't confirm message deletion
[ Register an autoalert for new messages
[JPop up an alert window when an autoalert is received
[[J Automatically check for new every check period (below)
Check period (in seconds) I 0
The messages will be fetched
@ at startup time O on demand
Maximum mailbox size I 100 l
’ Restore _Qefaults] | Apply ‘

IApply and Closel l Cancel [

Click “Apply and Close”.

XUXA Client

B3 XUXA (X.400 Mail User Agent) - /G=user/S=one/PRMD=X400/ADMD=lsode/C=GB/ - X

File Message View Help

& 2|3

4 .

B X

Get Mail — Write Reply  Reply Al Forward AddrBook Delete Mode
ailboxes P From Subject Received Size Sec
& Mailb = ml ;
] /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ Test 20/02/2025, 16:24 1Kb Y
© Inbox ) <SYSTEM> 1Kb J
 Outbox ] <SYSTEM> 1Kb J
[ Sent -] /G=user/S=one/PRMD=X400/ADMD=lIsode/C=GB/ IPN 20/02/2025, 16:24 1Kb J
2 Reports
@ Trash
= Previewl‘_‘(i Log| Sl ]
From: /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ Message Security:
TO:  /G=user/S=two/PRMD=X400/ADMD=Isode/C=GB/ 7J Signed (Not signed)
TO: /G=user/S=one/PRMD=X400/ADMD=lsode/C=GB/ —
| No Security Label
Subject:  Test
Date: 20/02/2025, 16:24 Bodyparts:
Priority: Normal T 1A5 Text

®  X.400 MTS Parameters

User One and User Two

Sent by User One.

Server status E_ @ E
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Select File->Preferences again.

XUXA Client

B3 XUXA (X.400 Mail User Agent) - /G=use
File Message View Help

&% Getall Mail Ctrl+G
{3] Open Address Book Ctrl+A
Preferences
Exit Ctrl+X

XUXA Client

B Preferences m] X

type filter text Xuxa Accounts SIhdloe R

v Xuxa Accounts
Bodyparts Make Default o Add
DSA and Address Book user two v
General 42 Copy X Delete
P3 Submission
P7 Message Store
Reports
Security

> Xuxa General

The default account is user one

Import Preferences Export Preferences | Delete All Preferences

Restore Defaults Apply

Apply and Close Cancel

Select “user two” in the Xuxa Accounts and Click “Apply and Close”.
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B XUXA (X.400 Mail User Agent) - /G=user/S=two/PRMD=X400/ADMD=Isode/C=GB/ = X
File Message View Help
3 2|3 B3 @l X|=.
| Get Mail Write Reply  Reply Al Forward AddrBook Delete Mode
& Mailboxess: = B || P From Subject Received Size Sec
) /G=user/S=one/PRMD=X400/ADMD=lsode/C=GB/ Test 20/02/2025, 16:24 1Kb o/
©3 Inbox
1 Outbox
(=] Sent
2 Reports
3 Trash
jPrMmlki Log[ = [m|
From: /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ Message Security:
TO:  /G=user/S=two/PRMD=X400/ADMD=lIsode/C=GB/ @ Signed (Not signed)
TO: /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/
“_ No Security Label
Subject:  Test
Date: 20/02/2025, 16:24 Bodyparts:
Priority: ~ Normal T 1A5 Text
® X400 MTS Parameters
User One and User Two &
Sent by User One.
A new message has arrived | Server status E @; [
You will see the message sent by “User One” - click the “Reply” Icon.
XUXA Client
2 New Message - a X
File Help

Send Attach me—

From: l/G:usu/S:two/PRMD:XMD/ADMD:Isode/C:GB/

v‘ Message Security:

=] TO: /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/

</ |Don't sign message L%

~ No Security Label

Priority:

Subject: | Re: Test

Priority: Normal v
| e

#®  X.400 MTS Parameters

YP

Enter some Body Text.

Evaluation Guide: M-Switch X.400

Page 39 of 65



Isode

XUXA Client
# New Message - m} X
File Help
G &
Send Attach me—
From: | /G=user/S=two/PRMD=X400/ADMD=Isode/C=GB/ v Message Security:
[ [ T10:  /G=user/S=one/PRMD=X400/ADMD=lsode/C=GB/ [PerRecip | ¢/ Don'tsign message -
- * No Security Label
Priority:
Priority: iNom\al v|
Subject: | Re: Test [ =
®  X.400 MTS Parameters
Message Received by User Two
Click the “Send” Icon.
XUXA Client
B Send Message X
Message submitted.
Message Submission ID:
[/PRMD=X400/ADMD=Isode/C=GB/;ISODE-X400.0540401-250220.163347]
IPM ID: 1 250220163347Z*/G=user/S=two/PRMD=X400/ADMD=Isode/C=GB/
Submission time: 250220163347Z
It took 484 milliseconds to construct and send the message
Click “OK.
XUXA Client
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BB XUXA (X.400 Mail User Agent) - /G=user/S=two/PRMD=X400/ADMD=Isode/C=GB/ =
File Message View Help
R R P B H X| = .
| GetMail  Write Reply  Reply Al Forward AddrBook Delete Mode
& Mailboxes] = B || P From Subject Received Size Sec
) /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ Test 20/02/2025, 16:24 1Kb o/
©3 Inbox ] <SYSTEM> 1Kb J
# Outbox
(=] Sent
A Reports
@ Trash
=R Previewl‘zi Log[ =
From: /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ Message Security:
TO:  /G=user/S=two/PRMD=X400/ADMD=Isode/C=GB/ m Signed (Not signed)
TO: /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ —
| No Security Label
Subject:  Test
Date: 20/02/2025, 16:24 Bodyparts:
Priority:  Normal T IAS Text
®  X.400 MTS Parameters
User One and User Two
Sent by User One.
A new message has arrived | Server status 3} 34 |
Now using the File->Preferences Switch Back to the User One Account.
XUXA Client
B3 XUXA (X.400 Mail User Agent) - /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ =
File Message View Help
& 2.3 @ X4 @|X|a.
. GetMaill  Write Reply  Reply Al Forward AddrBook Delete Mode
& Mailboxes] = B ||p  From Subject Received Size Sec
) /G=user/S=one/PRMD=X400/ADMD=lsode/C=GB/ Test 20/02/2025, 16:24 1Kb o/
©3 Inbox - <SYSTEM> 1Kb </
% Outbox ] <SYSTEM> 1Kb o/
) Sent ) /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ IPN 20/02/2025, 16:24 1Kb J
A Reports ] /G=user/S=two/PRMD=X400/ADMD=Isode/C=GB/ IPN 20/02/2025,16:31  1Kb J
@ Trash ] /G=user/S=two/PRMD=X400/ADMD=Isode/C=GB/ Re: Test 20/02/2025,16:33  1Kb o/
= Preview| 58 Logl =
From: /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ Message Security:
TO:  /G=user/S=two/PRMD=X400/ADMD=lsode/C=GB/ | )| signed (Not signed)
TO: /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ —
“ No Security Label
Subject:  Test
Date: 20/02/2025, 16:24 Bodyparts:
Priority:  Normal T IA5 Text
®  X.400 MTS Parameters
User One and User Two
Sent by User One.
A new message has arrived Server status
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You can see that the message has been received.

This completes the testing of Local Users. We now need to configure and External MTA and some
Address Book Entries.
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Adding an External MTA and Address Book entries

Configuring the External MTA with M-Console

Before connecting to an External MTA you will need to exchange information with them as
follows.

Your MTA Name:
Your MTA Password:
Your Hostname/IP Address:

Their MTA Name:
Their MTA Password:
Their Hostname/IP Address:

In this guide we will be connecting to the M-Switch MIXER MTA described in the M-Switch
MIXER Evaluation Guide and will use the following information.

Your MTA Name: ISODE-X400-EVAL

Your MTA Password: secret

Your Hostname/IP Address: ISODE-X400-EVAL (must resolve to an IP Address)
Their MTA Name: ISODE-MIXER-EVAL

Their MTA Password: secret

Their Hostname/IP Address: ISODE-MIXER-EVAL (must resolve to an IP Address)

From M-Console expand to Routing Tree to the ADMD “Isode”.

M-Console External MTA Routing Addition

u)]
X

[2] MConsole (Switch Configuration Management): messaging.admin@®ISODE-X400-EVAL -
File Window View Messaging Operations Help
"% Welcome to Message Console Switch Configuration Management X & Alerts {8 X.400 Mailbox Management [ Switch Operations

v Routing Trees
v @ Main Routing Tree MTAInfo  Filters
v &f C=GB
v ( ADMD=lsode MTA Group
(® PRMD=X400 )
v Message Transfer Agents Add
] ISODE-X400-EVAL
External Message Transfer Agents
v X.400 Message Stores
& Main Message Store
Subtree Information: (O All children present (@) Not all children present

Routing Nexus

Right Click on “ADMD=Isode”.
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M-Console External MTA Routing Addition

[Z] MConsole (Switch Configuration Management): ging.admin@I|
File Window View Messaging Operations Help
%] Welcome to Message Console |T‘ Switch Configuration Manage
v [ Routing Trees
v @ Main Routing Tree MTAInfo  Filters
v ElZ C=GB
v (9 ADMD=Isode AATA e

> @ PRMD=]  Search Users...
v [L) Message Transfer Age  Add X400 User / Address..
> =] ISODE-X400-EVAL Add Node...
| External Message Trar
v [ X.400 Message Stores Delete...
> & Main Message Stot Check Routing...

Select “Add Node...”.

M-Console External MTA Routing Addition
2 Createa Routing Tree node X

Select the node type and enter a value

Node type PRMD v [|

OK Cancel

Enter “Internet” for the “PRMD”.

M-Console External MTA Routing Addition

2 Createa Routing Tree node X

Select the node type and enter a value

Node type PRMD v |Internet

Click “OK”.

M-Console External MTA Routing Addition

] MConsole (Switch Configuration Manag: ) ing in@ISODE-X400-EVAL o X

File Window View Messaging Operations Help
%] Welcome to Message Console | Switch Configuration Management X B Alerts | 44 X.400 Mailbox Management A Switch Operations |

v | Routing Trees ~
v @ Main Routing Tree MTA Info  Filters
v £ C=GB
v (9 ADMD=Isode MTA Group
(® PRMD=X400
> (® PRMD=Internet Add
v [ Message Transfer Agents
> (=] ISODE-X400-EVAL Remove
| External Message Transfer Agents Edit
v (] X.400 Message Stores
> (g Main Message Store Subtree Information: (O All children present @) Not all children present

Routing Nexus

Right Click on “External Message Transfer Agents”
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M-Console Add External MTA

] MConsole (Switch Configuration Management): messaging.admin@ISODE-X
File Window View Messaging Operations Help

"% Welcome to Message Console ] Switch Configuration Management >

v [ Routing Trees
v @ Main Routing Tree
v 5i3 C=GB Under this folder you will find

v (® ADMD=lIsode External MTAs may be either |

(¥ PRMD=X400 or third-party MTAs which are
> (» PRMD=Internet
v || Message Transfer Agents An external MTA is the only w

> (=] ISODE-X400-EVAL
|| External Message Transfer As
v [ X.400 Message Stores
> (& Main Message Store

New External MTA...

Select “New External MTA...”

M-Console Add External MTA

Create a new MTA m] X

MTA type
Select the type of MTA you want to create

External MTA (Non Isode MTA, or non tailoring MTA)
@ X.400

O X.400 Gateway (using the Isode or Open Group Gateway API)
(O X.400 P1 File Gateway
(O X.400 P1 over HTTP Gateway

< Back Finish v Cancel

Select “X.400”, Click “Next>".
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M-Console Add External MTA

m Create a new MTA

MTA Naming

MTAs can be named in a number of different ways, depending on the

context.

The MTA Name, to be used in protocols (like X.400 P1 binds)

MTA name in protocol

The host name or IP address of the system on which the MTA will run

Fully Qualified Hostname I

The local Directory Name in this configuration (defaults to MTA Name)

Directory Name l

Optional local description for the new MTA

Description

< Back V Next >

Complete the details as below.

M-Console Add External MTA

Create a new MTA

MTA Naming

context.

Finish

MTAs can be named in a number of different ways, depending on the

Cancel

The MTA Name, to be used in protocols (like X.400 P1 binds)

MTA name in protocol | ISODE-MIXER-EVAL

The host name or IP address of the system on which the MTA will run

Fully Qualified Hostname I ISODE-MIXER-EVAL

The local Directory Name in this configuration (defaults to MTA Name)

Directory Name | Isode MIXER Gateway|

Optional local description for the new MTA

Description

’ < Back | Next > |

The “Directory Name” is free text use something that works for you. “Click Next>".

Finish

Cancel

Isode
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M-Console Add External MTA

[Z) Create a new MTA O X

Default Routing Tree for this MTA

Routing will be setup for the O/R Address Prefix selected, and the
default Internet domain selected earlier.

Choose a Routing Tree or Address Conversion Table. Use the tree navigation tool to select a partial
or complete O/R address, and then modify this value if necessary via the Edit button.

fting Tree,cn=Messaging Configuration,0=X400 ¥

2 el

> Main Routing Tree

Selected O/R Address

O/R Address | | Eit|

< Back . Finish v Cancel

Expand the “Main Routing Tree” until you get to “PRMD=Internet”.

M-Console Add External MTA

[ Create a new MTA O X

Default Routing Tree for this MTA

Routing will be setup for the O/R Address Prefix selected, and the
default Internet domain selected earlier.

Choose a Routing Tree or Address Conversion Table. Use the tree navigation tool to select a partial
or complete O/R address, and then modify this value if necessary via the Edit button.

cn=Main Routing Tree,cn=Messaging Configuration,o=X400 |

v Main Routing Tree
v C=GB
v ADMD=lsode
PRMD=Internet
> PRMD=X400

Selected O/R Address

O/R Address | /PRMD=Internet/ADMD=Isode/C=GB/ | Edit

< Back I Next > , . Cancel

Select “PRMD=Internet”, Click “Next>".

Isode
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M-Console Add External MTA

[ Create a new MTA a X

Remote X.400 MTA authentication details

Configure the authentication information to be used to connect to this
External X.400 MTA

Remote MTA Name to use in the bind | ISODE-MIXER-EVAL |

Remote MTA password to use in the bind I | Show

< Back Next > Cancel

The Remote MTA Name will auto-populate make sure it matches the MA Name you have been
given and then enter the Password you have been given.

M-Console Add External MTA

[Z] Create a new MTA O X

Remote X.400 MTA authentication details

Configure the authentication information to be used to connect to this
External X.400 MTA

Remote MTA Name to use in the bind | ISODE-MIXER-EVAL |

Remote MTA password to use in the bind [ secret ] Hide

< Back Next > Finish Cancel

Click “Finish”.
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M-Console Add External MTA

? Windows R19.0 M-Switch X.400 Eval Guide on BLOODHOUND - Virtual Machine Connection = (m]
File Action Media Clipboard View Help

BEO®OO n»|f O B

[Z] MConsole (Switch Configuration Manag ) ing.admin@ISODE-X400-EVAL = X
File Window View Messaging Opefations Help
%] Welcome to Message Console [' Switch Configuration Management X & ! Alerts | i) X.400 Mailbox M. | Switch Operations |
v [_| Routing Trees ~
v @ Main Routing Tree MTAInfo  Filters
v EfE C=68B
v (® ADMD=lsode MTA Group
(® PRMD=X400
> (¥ PRMD=Intemet Isode MIXER Gateway, MTA weight : 5 Add
v [ Message Transfer Agents
> [ ISODE-X400-EVAL ST
> [ External Message Transfer Agents Edit
v [.] X.400 Message Stores
> |& Main Message Store Subtree Information: O All children present @ Not all children present
Routing Nexus
You will see that this new MTA has been added as the MTA for the PRMD=Internet. We now
need to configure the Password for our x400p1 Channel. Expand our MTA and Channels then
select the x400p1 channel and select the Auth Tab.
M-Console Configure X.400 P1 Channel
[Z] MConsole (Switch Configuration Manag ) ing in@ISODE-X400-EVAL = =] X
File Window View Messaging Opgrations Help
"% Welcome to Message Console | Switch Confi ion Manag X @ Alets | ] X400 Mailbox M | [& Switch Operations
v [_] Routing Trees ~
v @ Main Routing Tree Main  Program Tables Inbound Auth  RTSE  MTALinks Advanced
v EjZ C=GB s 3
- Authentication Requirements
v (» ADMD=Isode “
_ Allows selection of hods used to authenticate the resp to connections which the channel initiates (initiator), and to
N g ::LT[)D—I::,:OQ incoming connections to which the channel responds (responder).
v [ Message Transfer Agents Plinitiator | MTA-NAME-PRESENT § SIMPLE-AUTHENTICATION | | Edit

v = ISODE-X400-EVAL
v [_| Channels

P1Responder | MTA-NAME-PRESENT $ SIMPLE-AUTHENTICATION | Edit
@ housekeeper
Q mhsshaper
@3 p3deliver Credentials
g pi;’:’ Credentials which the channel will supply when initiating a connection (initiator), or in response to a connection (responder).
x400-
@ x400mt Initiator RTS Credentials Edit
3 x400p1 :
> [ Tables .
(® Routing Nexus Responder RTS Credentials Edit
> [ Directory Profiles
> [ Logs

> [ External Message Transfer Agents
v [-) X.400 Message Stores
> (& Main Message Store

Click “Edit” on the “Initiator RTS Credentials”.

M-Console Configure X.400 P1 Channel

[Z] Initiator RTS Credentials X

The credentials to be used in the request when ISODE-X400-EVAL connects to another

MTA

Request MTA Name | ISODE-X400-EVAL |
Request MTA Password I I [JEmpty Show |

Change the auto-generated Password to “secret”.
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M-Console Configure X.400 P1 Channel

[ Initiator RTS Credentials X

The credentials to be used in the request when ISODE-X400-EVAL connects to another
MTA

Request MTA Name | ISODE-X400-EVAL ]

Request MTA Password I secret] | [JEmpty | Hide

ok || cancel

Click “OK”. Repeat the process for the “Responder RTS Credentials”.

M-Console Configure X.400 P1 Channel

Responder RTS Credentials X
The credentials to be used in the response when ISODE-X400-EVAL responds to another
MTA
Response MTA Name | ISODE-X400-EVAL ]
Response MTA Password [ secret I [JEmpty | Hide
oK | | Cancel
Click “OK”.

M-Console Configure X.400 P1 Channel

T MConsole (Switch Configuration M ) ing.admi

ISODE-X400-EVAL — X
File Window View Messaging Operations Help
&) Welcome to Message Console j Switch Configuration Management X\ @ Alerts X.400 Mailbox Management | [ Switch Operations |
v [ Routing Trees ~
v @ Main Routing Tree Main  Program Tables Inbound Auth  RTSE  MTALinks Advanced
v &i3 C=GB Authentication Requirements
v ( ADMD=lsode . " i
3 Allows selection of hods used to authenti the resp to which the channel initiates (initiator), and to
5 g ::x;;::’?;t incoming connections to which the channel responds (responder).
v [ Message Transfer Agents Plinitiator I MTA-NAME-PRESENT $ SIMPLE-AUTHENTICATION ] Edit
v (=] ISODE-X400-EVAL
Yo é":";":':mper P1Responder | MTA-NAME-PRESENT § SIMPLE-AUTHENTICATION | | Eit
u i
@3 mhsshaper
&3 p3deliver Credentials
g p:(s);::r Credentials which the channel will supply when initiating a connection (initiator), or in resp: to a connection (responder).
X
£ x400mt Initiator RTS Credentials Edit|
{3 x400p1
> [ Tables
(¥ Routing Nexus Responder RTS Credentials
> [ Directory Profiles
> [LJ Logs
> [_J External Message Transfer Agents
v [ X.400 Message Stores
> (& Main Message Store
v
Apply | Cancel

Click “Apply”. We now need to test the Connection, Right Click on the x4oop1 Channel.
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M-Console Test Connection to External MTA
=

Test an X.400 Connection

Click on the ‘Run Test' to initiate a connection attempt from:
cn=x400p1,cn=ISODE-X400-EVAL,cn=Messaging Configuration,0=X400

To Remote MTA / Channel:

cn=x400p1,cn=Isode MIXER y,cn=M ging Configuration,o=X400
00p ode R ging Config on,0=X400

cn=x400p1,cn=ISODE-X400-EVAL,cn=Messaging Configuration,o=X400

RunTest | Clear

Select the New MTA (cn=Isode MIXER Gateway...). Click “Run Test”.

M-Console Test Connection to External MTA

@

X
Test an X.400 Connection
Click on the 'Run Test' to initiate a connection attempt from:
cn=x400p1,cn=ISODE-X400-EVAL,cn=Messaging Configuration,0=X400
To Remote MTA / Channel:
cn=x400p1,cn=Isode MIXER G, y,cn=Messaging Configuration,0=X400 v

Checking to see if there is an existing connection.

No existing P1 Connections to: cn=x400p1,cn=Isode MIXER Gat
Performing P1 channel connect:

Connecting...0

Connecting...1

Connecting...2

Connecting...3

Checking to see if connection established

Successfully established P1 connection from:
cn=x400p1,cn=ISODE-X400-EVAL,cn=Messaging Configuration,o=X400

y,cn=Messaging Configuration,o=X400

to:

cn=x400p1,cn=Isode MIXER Gateway,cn=Messaging Configuration,o=X400

Run Test

Close

If you do not see a successful connection check Port 102 is open on both machines. We now need
to check the Routing.

From the “Top Menu” Click “Messaging.
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M-Console Check Routing

MConsole (Switch Configuration Management): messaging.admin@ISOD
File Window View Messaging Operations Help

"% Welcome to Messac MHS Management >
v || Routing Trees Create MTA Links
v @ Main Routint Summary...
v Elg C=GB : . :
- Upgrade Messaging Configuration... :
M C:g k Add z :t i
® PRI ec ress Routing...
> (® PRA Backup Messaging Configuration...
v [ Message Transf¢ System Check... )
ws 8 IROANE_YANN_ L 1 -

Select “Check Address Routing...”.

M-Console Check Routing

[Z] Check Routing X

Test email address routing
Click on the 'Check Address' to start the test

Basic  Advanced

Switch: | ISODE-X400-EVAL v

Address To: | [Edit| | Swap Addresses

Address From: Edit [JInclude From Address

v Check Address | [ Clear

Click “Edit” next to “Address To:”.
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M-Console Check Routing

O/R Address Editor X
Name Form Partial v
Country Name l GB I Administrative Domain [Jspace
Private Domain I Internet ‘ Organization I |

Organizational Unit #1 |: Organizational Unit #2 I I
Organizational Unit #3 I: Organizational Unit #4 I I

Surname [ one I Initials I ‘

Given Name I user| I Generation Qualifier | |

Common Name I |

X121 Address | |

Terminal ID I I

Domain-defined type | | = I l +

3 I

Enter the details for the remote user and Click “OK”. Then Click “Check Address”.

M-Console Check Routing

[Z] Check Routing X

Test email address routing
Click on the 'Check Address' to start the test

Basic  Advanced

Switch: | ISODE-X400-EVAL v |

AddressTo: | /G=user/S=one/P=Intemet/A=lsode/C=GB/ | [Edit| [Swap Addresses

Address From: £dit [JInclude From Address

x400address: /G=user/S=one/PRMD=Internet/ADMD=Isode/C=GB/

delivered-mta: cn=x400p1,cn=Isode MIXER Gateway,cn=Messaging Configuration,o=X400
delivered-channel: x400p1

channel-weight: 5

| Check Address |

Close

You should see it routing to the new Remote MTA. We now need to Add the Remote Users to the
White Pages Address Book for XUXA. We will use and Isode GUI called “Sodium” for this.
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Adding Address Book Entries with Sodium

If running on Linux use the following command.
% /opt/isode/bin/sodium
From Windows Start->Isode Ri9.0>Sodium (Secure Open Data, Identity... .

Start Sodium

. Isode 19.0

SPIF Editor

Isode Service Configuration

LogConfig (Isode Log Configuration...

MConsole (Message Switch Console)

M-Vault Console

$5066 Console

Sodium (Secure Open Data, Identity...

Sodium CA (Sodium Certificate Auth...

BB Y11%A (X400 Demn Lser Anent)

£ flype here to search

Enter Sodium Passphrase

¥, Profile passphrase Required X

The file "C:\Users\Administrator\AppData\Roaming\Isode\isode-bindprofile-r15.xml"
is protected by your Profile passphrase.

Either enter your passphrase, or press CANCEL to run Sodium without loading or
saving any bind profiles.

Passphrase: | |

Cancel

Enter the Passphrase (same as for M-Console).

Enter Sodium Passphrase

¥, Profile passphrase Required X

The file "C:\Users\Administrator\AppData\Roaming\Isode\isode-bindprofile-r15.xml"
is protected by your Profile passphrase.

Either enter your passphrase, or press CANCEL to run Sodium without loading or
saving any bind profiles.

Passphrase: | eseese

o one

Click “OK”.
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£ Bind Profile Management

Configured Binds (encrypted)

cn=dsa,0=X400 / Messaging Admin

Certificates... ‘

Click “Connect”.

Sodium View

0 cn=dsa,0=X400 / Messaging Admin - Sodium
Session Edit Operations X.509 View Help

New...
Modify...
Copy
Rename...

Delete

Passphrase... ‘

Close

| Browse SO

(B) ¥, “cn=dsa,0=x400 / Messaging Admin’: LDAP bind to 'ISODE-X400-EVAL' on port 19389

> @ World

Isode

Expand the View from “World” until you reach “White Pages”, the Right Click on “White Pages”.

Sodium Add below

%7 cn=dsa,0=X400 / Messaging Admin - Sodium
Session Edit Operations X.509 View Help

Browse: White Pages... X 3

@ i}, "cn=dsa,0=X400 / Messaging Admin": LDAP bind to

v @ World
> [ cn=config
v 5 0=X400
@ cn=Address Book
> @ cn=Groups
> [ cn=Messaging Configuration
> @ cn=Users
v [ cn=White Pac~
B cn=useror Browse
B cnzusertw Search...
Compare...

Copy DN

Rename
Add below...
Delete

Refresh

Bulk tools >

Select “Add below...”.
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. Add entry under: cn=White Pages,0=X400

Select template to add
Choose the template suitable for the entry you wish to add

8 Person

&g Group of Names

% Organizational Role

% Organizational Unit

& Organization

% City/Locality

4 Country

@ Domain Component

@ Device

Cn Alias

[ Domain defined user

[ Access Control User

£ MTA

s External MTA

@ Container

@ Extensible Object

9. Isode Internet File Transfer By Email User
7. Isode Internet File Transfer By Email Peer
{¥] MHS Distribution List

{%) Internet Distribution List

Finish

Cancel

Click “Next>".

Sodium Add below

¥, Add entry under: cn=White Pages,0=X400

Select optional parts
Select which optional parts of the template apply

"Person” template options:

. Organizational Person

_ Internet Organizational Person
_ Isode Harrier User

_ Isode M-Box User

_ Isode M-Box Gateway User

. X400 Messaging

_ ATN AMHS User

. PKl User

_ PKICA

_ Certification Authority

_ Entrust CA

| HTTP Resource

_ (NIS) POSIX Account

_ (NIS) POSIX Shadow Password
. Password Policy Exclusion

_ Account Lock

JOO00D0O00O0000o0OrROOOoOr™

| Clearance

Finish

Cancel

Isode

Check “Organizational Person”, “Internet Organizational Person”& “X.400 Messaging”.

Click “Next>".
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. Add entry under: cn=White Pages,0=X400

Enter RDN
Enter the RDN value for the new entry

Full Name user one internet]

{ < Back \

Enter a “Full Name”, in this case we will use “user one internet”, Click “Finish”.

Sodium Add below

%5 cn=dsa,0=X400 / Messaging Admin - Sodium
Session Edit Operations X.509 View Help

¥ Browse: White Pages... X

Isode

{', “cn=dsa,0=X400 / Messaging Admin": LDAP bind to 'ISODE-X400-EVAL' on port 19389

v & World
> cn=config
v & 0=X400
@ cn=Address Book
> @ cn=Groups
> cn=Messaging Configuration
> @ cn=Users
v cn=White Pages
§ cn=userone
B cn=usertwo

Add “internet” for “Surname” .

A Personal Group Contact Other Address Photo

Employee A Messaging

vTempIat:view v| i‘l

Full Name I user one internet

Surname £ |

User Password

Password | < No value available >

E-mail [

]

User Certificate

Save.. | SaveasPEM.. ' Remove >Load...‘ vRequst...- >Impon...‘ Verify...

User S/MIME Certificate

Save.. |SaveasPEM..  Remove| |Load..| Verify..

Add another... |Clone... |Object classes...

& [ Add | [ cancel |
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%, cn=dsa,0=X400 / Messaging Admin - Sodium
Session Edit Operations X.509 View Help

ﬁ Browse: White Pages... X

"ﬂ "cn=dsa,0=X400 / Messaging Admin": LDAP bind to 'ISODE-X400-EVAL' on port 19389

v & World
> cn=config
v & 0=X400
@ cn=Address Book
> @ cn=Groups
> cn=Messaging Configuration
> @ cn=Users
v cn=White Pages
£ cn=userone
8 cn=usertwo

Select the “Messaging” tab.

Sodium Add below

%5 cn=dsa,0=X400 / Messaging Admin - Sodium
Session Edit Operations X.509 View Help
17 Browse: White Pages... X

Personal Group Contact Other

Template view v

Address Photo Employee 4h Messaging

Full Name | user one internet

Surname ] internet

User Password

Password

| < No value available >

E-mail [

User Certificate

Save...| | Save as PEM...

User S/MIME Certificate

Save...|  SaveasPEM...

[Addznothers| [Cionen| [Object classes...

Remove {Load...} [RequstJ llmpon...J Verify...

A | Add | Cancel

WL "cn=dsa,0=X400 / Messaging Admin": LDAP bind to 'ISODE-X400-EVAL' on port 19389

v & World
> cn=config
v 5% 0=X400
@ cn=Address Book
> @ cn=Groups
> cn=Messaging Configuration
> @ cn=Users
v cn=White Pages
£ cn=userone
8 cn=usertwo

Personal Group Contact Other

OR Addresses £
Maximum Content Length
Message Store DN
Deliverable Content Types
Acceptable EITs
Exclusively Acceptable EITs
Unacceptable ElTs

O/R Addresses with Capabilities

Add another...| |Clone... | Object classes...

Click “Edit” next to the OR Address.

Template view v D

Address Photo Employee 4h Messaging

[ | [ea | [+
| |
o |
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Sodium Add below

% O/R Address Editor

Name Form IPersonal Name

Country Name I GB

| Administrative Domain | Isode

| [JSpace | |

Private Domain I Internet

I Organization I

Organizational Unit #1 |

| Organizational Unit #2 |

Organizational Unit #3 |

|  Organizational Unit #4 |

Surname I one

I Initials I

Given Name I user

I Generation Qualifier |

Domain-defined type l

Complete the form as above, Click “OK”.

Sodium Add below

B cn=dsa,0=X400 / Messaging Admin - Sodium
Session Edit Operations X.509 View Help

ﬁ Browse: White Pages... X

?L “cn=dsa,0=X400 / Messaging Admin": LDAP bind to 'ISODE-X400-EVAL' on port 19389

v & World
> cn=config
v é% 0=X400
@ cn=Address Book
> @ cn=Groups
> cn=Messaging Configuration
> @ cn=Users
v | | cn=White Pages
8 cn=userone
B cn=usertwo

Click “Add”.

Personal Group Contact Other Address Photo Employee Messaging

Ftanren |

OR Addresses

I /G=user/S=one/PRMD=Internet/ ADMD=Isode/C=GB/

| [Est] [+

Maximum Content Length |

Message Store DN v |

el

Deliverable Content Types [

[

Acceptable EITs [

|

Exclusively Acceptable EITs |

|

Unacceptable EITs l

1]

O/R Addresses with Capabilities

Add another... | Clone... Object classes...

View! Save.| | Delete [+ |

[ ada | [ cancel |
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0 cn=dsa,0=X400 / Messaging Admin - Sodium - X
| Session Edit Operations X.509 View Help

Browse: user one in... X

;',, "en=dsa,0=X400 / Messaging Admin": LDAP bind to 'ISODE-X400-EVAL' on port 19389 \rTemplit! view v| [ 7"
v @ World Personal Group Contact Other Address Photo Employee Messaging
> [ en=config o
v & o0=Xd00 OR Addresses [ /G=user/S=one/PRMD=Intemet/ADMD=Isode/C=GB/ || Edit | |+
@ cn=Address Book -
> O\ cn=Groups Maximum Content Length [ |
> [ cn=Messaging Configuration
> ? cn=Users Message Store DN I | [pi‘k‘ ;]
v |7 cn=White Pages )

g ::j:z:: ::: e Deliverable Content Types | |

a cn=user two

Acceptable EITs I

Exclusively Acceptable EITs |

Unacceptable ElTs I

O/R Addresses with Capabilities View | Save.. Delete :‘

Repeat the process for “user two internet”.

Sodium Add below

% cn=dsa,0=X400 / Messaging Admin - Sodium = > &
Session Edit Operations X.509 View Help

Browse: user two in... X

) “cn=dsa,0=X400 / Messaging Admin": LDAP bind to 'ISODE-X400-EVAL' on port 19389 [emplate view | [af"
v @ World Personal Group Contact Other Address Photo Employee Messaging
> [ cn=config o
v & o=x400 OR Addresses [ /G=user/s=two/PRMD=Intemet/ADMD=Isode/C=GB/ || Edit | [+]
@ cn=Address Book o
> ’ cn=Groups Maximum Content Length I |
> [ cn=Messaging Configuration
> @ cn=Users Message Store DN I
v [% cn=White Pages
cn=user one i
g cn=user.one infemet Deliverable Content Types I
B cn=usertwo
£ cn=user two internet Acceptable EITs I
Exclusively Acceptable EITs I
Unacceptable EITs I
O/R Addresses with Capabilities View|[Save...| Delete [+ |

This completes adding the Address Book entries for XUXA.
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Sending a Message to an External X.400 User with XUXA.
From XUXA Click the “Write” Icon.

XUXA Sending a Message to a Remote User

2 New Message = o X
‘ File Help
e ¢ &
Send Attach Cmp—
‘ From: | /G=user/S=one/PRMD=X400/ADMD=lsode/C=GB/ v Message Security:
J 't 5i
! @ Don't sign message
‘ No Security Label
‘ Priority:
Priority:  Normal v
Subject: | | =

® X.400 MTS Parameters

Click the “Address Book Icon”,

XUXA Sending a Message to a Remote User

\u Address Book X

TheWorld v Not bound | Edit with SODIUM

8 /G=user/S=two/PRMD=X400/ADMD=lsode/C=GB/
8 /G=user/S=two/PRMD=Internet/ADMD=lsode/C=GB/ To: ->
8 /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/

8 /G=user/S=one/PRMD=Internet/ADMD=Isode/C=GB/

BCC: ->

Alt Recipient: ->

Attribute Value

Select /G=user/S=one/PRMD=Internet/ADMD=Isode/C=GB/, Click “OK”.
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XUXA Sending a Message to a Remote User

2 Test MIXER = (m] X
File Help

Send Attach g

From: | /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/ RS c=s20ebectinty:
[ ') | TO: /G=user/S=one/PRMD=Internet/ADMD=Isode/C=GB/ Per Recip </ Don't sign message v
No Security Label
Priority:
Priority: Normal N

Subject: | Test MIXER |

Bodh
YP

#®  X.400 MTS Parameters

Test

Enter a Subject and some test, then Click the “Send” Icon.

XUXA Sending a Message to a Remote User

= Send Message X

Message submitted.

Message Submission ID:
[/PRMD=X400/ADMD=lsode/C=GB/;ISODE-X400.0328001-250224.080020]

IPM ID: 1 250224080020Z*/G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/
Submission time: 250224080020Z

It took 438 milliseconds to construct and send the message

Click “OK”.
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XUXA Sending a Message to a Remote User

B XUXA (X.400 Mail User Agent) - /G=user/S=one/PRMD=X400/ADMD=Isode/C=GB/

=
File Message View Help
& 2. P b : = .
Get Mail ~ Write Reply  Reply Al Forward AddrBook Delete Mode
& Mailboxes; = B || P From Subject Received Size Sec
] /S=postmaster/PRMD=Internet/ADMD=Isode/C=GB/ Delivery report (success) for /G=us... 1Kb J
3 Inbox ] /G=user/S=one/PRMD=Internet/ADMD=Isode/C=GB/ IPN 24/02/2025, 08:06 1Kb o/
) Outbox
) Sent
A Reports
@ Trash

[ Preview‘ _Q Log[

From: /S=postmaster/PRMD=Internet/ADMD=Isode/C=GB/
TO: /G=user/S=one/PRMD=Internet/ADMD=Isode/C=GB/

Subject:  Delivery report (success) for /G=user/S=one/PRMD=Internet/ADMD=Isode/C=GB/
Date:

Priority: No Priority

®  X.400 MTS Parameters

Message Security:
. Not Signed

* No Security Label

Bodyparts:

Delivery Report for your message with

It was successfully sent to: /G=user/S=one/PRMD=Internet/ADMD=Isode/C=GB/
Message Delivery Time: 250224080535Z

Subject Identifier: [/PRMD=X400/ADMD=Isode/C=GB/;ISODE-X400.0328001-250224.080020]

Listed 4 messages in the Sent folder

You can see the

successful Delivery Report above.

This completes the Guide.

‘ Server status ﬁ\a D;\
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What Next?

More information on M-Switch X.400 can be found on the Isode website at
https://www.isode.com/product/x-400-message-switch/.

Whitepapers

Isode regularly publishes whitepapers on technical and market topics related to its products. A
full list of these can be found at https://www.isode.com/whitepapers/.
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Copyright

The Isode Logo and Isode are trade and service marks of Isode Limited.

All products and services mentioned in this document are identified by the trademarks or service
marks of their respective companies or organizations, and Isode Limited disclaims any
responsibility for specifying which marks are owned by which companies or organizations.

Isode software is © copyright Isode Limited 2002-2025, All rights reserved.

Isode software is a compilation of software of which Isode Limited is either the copyright holder
or licensee. Acquisition and use of this software and related materials for any purpose requires a
written licence agreement from Isode Limited, or a written licence from an organization licensed
by Isode Limited to grant such a licence.

This manual is © copyright Isode Limited 2025.
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